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Remote Visualization Motivation

• It is no longer necessarily practical to move tera 
and peta-scale data from instruments or HPC 
systems to user’s local site

• Certain data is sensitive (e.g. data from industry, 
government, academia)

• Growth of data has outstripped the graphics 
capabilities of single GPUs and aggregation of 
GPUs requires specialized knowledge



Remote Visualization Challenges

• Latency (wide-area network and GPU read-back)
• Quality of service and the user interface                     

(scheduling, ease of access, and usability)
• Wide-area network bandwidth                              

(1280 * 1024 * 12 * 24 = 360 MBps uncompressed)
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New Model
Multi-User and Collaborative Capability
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Starting a Remote Visualization Job on 
Maverick (Lab Exercise)

Step 1: Download a vnc client. Recommended option 
is TurboVNC which can be downloaded from:

http://www.virtualgl.org/Downloads/TurboVNC



Starting a Remote Visualization Job on 
Maverick (Lab Exercise)

Step 2: ssh maverick.tacc.utexas.edu



Starting a Remote Visualization Job on 
Maverick (Lab Exercise)

Step 3: On maverick, set up your vnc password. This 
only needs to be done once, but is attached to 
the machine you are currently logged into. 

Type ‘vncpasswd’ and hit return. This will 
prompt you for a password. Type in something 
that you can easily remember and hit enter. 
You will then be asked to verify the password.



Starting a Remote Visualization Job on 
Maverick (Lab Exercise)

Step 4: type 
‘qsub -v GEOMETRY=1600x1200 -l h_rt=1:00:00 -l gfx=1 /usr/local/qsub/RUN.vnc’

qsub = Method to submit job to the 
queue

GEOMETRY sets the size of the vnc
window

-l h_rt=1:00:00 sets the job run time to 
1 hour

-l gfx=1 requests 1 graphics card

/usr/local/qsub/RUN.vnc is the script 
to start the vnc session



Starting a Remote Visualization Job on 
Maverick (Lab Exercise)

Step 5: type ‘qstat’ to see the status of your job

q = job is still queued

t = job is still being transferred 
to the SGE manager

e = job has errorred out and 
possible causes can be found 
in the file vnc.log in your home 
directory

r = job is running



Starting a Remote Visualization Job on 
Maverick (Lab Exercise)

Step 6: Find the display that your job is running on by looking in 
the file vnc_server in your home directory

You will see a display address, 
for example:

mav1.tacc.utexas.edu:5902

This tells you to connect to 
display 2 on 
mav1.tacc.utexas.edu



Starting a Remote Visualization Job on 
Maverick (Lab Exercise)

Step 7: Connect to that display by using a vnc client

(1)

(2)

(3)



Starting a Remote Visualization Job on 
Maverick (Lab Exercise)

Step 8: Type ‘module avail’ in the xterm. 

This will tell you which 
programs are available to load 
and run.



Starting a Remote Visualization Job on 
Maverick (Lab Exercise)

Step 9: Type ‘module load paraview/3.2.1’

This will load paraview 3.2.1 
and make it available for 
running.



Starting a Remote Visualization Job on 
Maverick (Lab Exercise)

Step 10: Type ‘vglrun paraview’. vglrun is necessary to 
run any OpenGL based applications through 
the vnc viewer.



Starting a Remote Visualization Job on 
Maverick (Lab Exercise)



Starting a Remote Visualization Job on 
Maverick (Lab Exercise)

Step 11: Load the RectGrid2.vtk dataset. It can be found in 
/work/utexas/staff/kelly/PORTUGAL



Starting a Remote Visualization Job on 
Maverick (Lab Exercise)

Step 12: You can also view through a web browser. The web 
address can be found in vnc_url in your home directory.
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EnVision: Web-Based Remote 
Scientific Visualization 

EnVision Team: Greg P. Johnson, Stephen Mock, Greg S. 
Johnson



Motivation for EnVision

• Most visualization software takes significant 
time and effort to learn effectively 

• EnVision was created with these audiences in 
mind:  
1. Computational scientists with little to no 

visualization experience
2. Users who want to quickly import and 

visualize their data from anywhere



EnVision Goals:  Simple, Intuitive, 
Immediate

• Web-based visualization application with a 
wizard-style interface

• Does not aim to supersede or replace current 
visualization applications

• Focus is on simplicity and ease-of-use
• Semi-automates the data importation process
• Presents visualization methods, with examples, 

that are applicable to their data set



EnVision Guides the User Through the 
Process

1. Authenticates user, shows visualization resources, and 
automatically starts a remote visualization job on selected 
resource

2. Imports data in nearly any format based on a series of 
intuitive questions

3. Presents user with examples of visualization methods to 
add

4. Builds the visualization using reasonable defaults for 
color mapping, etc. 

5. Renders the visualization and allows user to interact with 
it and save snapshots



EnVision General Architecture



Current State and Future Plans

• Version 2.0b1 released June 9, 2008
• Current capabilities:

– TACC Maverick visualization resource
– supports any VTK formatted data set
– structured and point arbitrarily formatted data importation through 

interview
– basic visualization methods

• Future capabilities include:
– additional visualization resources
– additional visualization methods (e.g. volume rendering)
– collaborative visualization sessions
– unstructured arbitrarily formatted data importation through interview
– automated data staging



EnVision Demo

https://envision2.tacc.utexas.edu

https://envision2.tacc.utexas.edu/


EnVision Demo

Step 1: Login in to your maverick account and type the 
following command:

cp –R ~train00/envision_demo ./

Then log out of maverick



EnVision Demo

Step 2: Login and authenticate: goto
http://envision2.tacc.utexas.edu



EnVision Demo

Step 3: Select the resource. (Maverick)



EnVision Demo

Step 4: Load the data.



EnVision Demo

Step 5: Select the type of visualization you want to see.



EnVision Demo

Step 6: Create a heightmap.



EnVision Demo

Step 7: Create an isosurface.



EnVision Demo

Step 8: Create glyphs.
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Visualizing and Animating a Time Varying 
Dataset

• Download the data from your maverick account at 
/work/utexas/staff/kelly/PORTUGAL/

• The data is called sol_data.tar.gz
• gunzip the file: gunzip sol_data.tar.gz
• Untar the file: tar –xvf sol_data.tar
• This will produce a series of time steps



Visualizing and Animating a Time Varying 
Dataset

• Step 1: In paraview, locate the time series data, select it and 
load the data.



Visualizing and Animating a Time Varying 
Dataset

• Step2: Find the data’s information and verify that all time steps 
were loaded.



Visualizing and Animating a Time Varying 
Dataset

• Step 3: In the File menu, select “Save Animation”. This will 
animate the time series.



Visualizing and Animating a Time Varying 
Dataset

• The movie should look like:



Visualizing and Animating a Time Varying 
Dataset

• Step 4: Add particle traces using a line to seed the 
points. Change the color to black and line width to 1.



Visualizing and Animating a Time Varying 
Dataset

• Step 5: Go back to the contour and turn it back on.



Visualizing and Animating a Time Varying 
Dataset

• Step 6: Save an animation of this view.



Visualizing and Animating a Time Varying 
Dataset

• The movie should look like:
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VisIt
• Open source parallel visualization tool out of LLNL
• Key features:

– Scalar, vector, and tensor field visualization
– Structured and unstructured mesh types
– Support for structured AMR meshes and CSG 

meshes\
– Quantitative analysis (expressions, queries, 

picking, lineout)
– GIS support
– Image export (BMP, JPEG, PNG, PPM, Raster

Postscript, RGB, TIFF, stereo images)
– Annotation support for publication and 

presentation graphics
– Built on VTK (open source graphics library)



VisIt Supported File Formats

ANALYZE FVCOM PLOT3D
ANSYS GGCM Protein Databank
BOV (brick of values) H5Nimrod SAMRAI
Boxlib H5Part Silo
CGNS Image Spheral
Chombo ITAPS STL
CTRL MFIX TecPlot
Curve2D MM5 VASP
Ensight Gold NASTRAN Vis5D
Enzo Nek3D VTK
Exodus NetCDF Wavefront OBJ
FITS OpenFOAM Xmdv
FLASH PATRAN ZeusMP (HDF4)
FLUENT
GIS (DEM, ArcGrid, ESRI Shapefile, vector file formats…)



Running VisIt

• Download from web 
and install on local 
computer

• Download from web 
and install on local 
computer



VisIt Application
Database Viewer 
(File List)

Viewer (Output Window)

Animation 
Controls

Plot List

Plot and Operator 
Menus

Status Bar



Visit Terminology

• Plot = Mapping Algorithm
– Pseudocolor plot (scalar color map)

– Surface plot (of 3D isosurface or 2D data)

– Volume plot (3D volume rendered image)

• Operator = Data Manipulation Algorithm
– Slice  (extract data)

– Resample (change data resolution)

– Transform (move data in space or time)

• Database = file or set of files



Common Plots
Contour Pseudocolor

Surface



Common Plots

Mesh + Pseudocolor

Volume



VisIt Advanced Features

• Various lighting, rendering, and view (camera) options
• Geometry export (Curve, Alias WaveFront Obj, STL, ULTRA, 

and VTK) 
• Animation and movie generation
• Scripting interface with Python
• API interface with C++ and Java
• Dynamically extensible through plugins
• Parallel and distributed architecture for visualizing very large

data sets
• Database export (BOV, SILO, Tecplot, SimV1Writer, VTK, 

columnar ascii file (xmdf))
• Multiple database correlation / visualization



Download VisIt and Go Through Example
• Step 1: Download VisIt from

– https://wci.llnl.gov/codes/visit/executables.html



Download VisIt and Go Through Example
• Step 2: Bring up VisIt and Load the 

RectGrid2.vtk dataset



Download VisIt and Go Through Example
• Step 3: Create a surface plot (pseudocolor) of 

the volume boundary by clicking on plots and 
selecting pseudocolor.



Download VisIt and Go Through Example
• Step 4: Swap the background color and 

foreground color



Download VisIt and Go Through Example
• Step 5: Create a set of isosurfaces by clicking 

on plots and selecting contours.



Download VisIt and Go Through Example
• Step 6: Create a set of streamlines by clicking 

on plots and selecting streamline



Download VisIt and Go Through Example
• Step 7: Create volume by selecting volume in 

plots



Download VisIt and Go Through Example
• Step 8: Adjust the volume rendering color 

profile



Download VisIt and Go Through Example
• Step 9: Adjust the transparency and color of 

isosurfaces
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Parallel Visualization

• Three types of parallelism to think about:
– Task parallelism – passing results to 1 process for 

rendering
1 2 3 4 5

1 Read file 1 Isosurface 1 Cut Plane 1

2 Read file 2 Streamlines 2 Render

3 Read file 3 Triangulate 3 Decimate 3 Glyph 3

Timesteps

Pr
oc

es
se

s



Parallel Visualization
• Three types of parallelism to think about:

– Pipeline parallelism – useful when processes have access to 
separate resources or when an operation requires many 
steps.

1 2 3 4 5

1 Read file 1 Read file 2 Read File 3

2 Isosurface 1 Isosurface 2 Isosurface 3

3 Render 1 Render 2 Render 3

Timesteps

Pr
oc

es
se

s



Parallel Visualization
• Three types of parallelism to think about:

– Data parallelism – data set is partitioned between the 
processes and all processes execute same operations on the 
data. Scales well as long as the data and operations can be 
decomposed.

1 2 3

1 Read 
partition 1

Isosurface
partition 1

Render 
partition 1

2 Read 
partition 2

Isosurface
partition 2

Render 
partition 2

3 Read 
partition 3

Isosurface
partition 2

Render 
partition 3

Timesteps
Pr

oc
es

se
s



Questions?



Parallel Paraview
• Paraview has three main logical components:

– Client server responsible for user interface of the 
application

– Data server reads and processes data sets to 
create final geometric models. Each process is told 
which partition of the data it should load

– Render Server is responsible for rendering the final 
geometry. The render server can run in parallel if it 
is configured to do so.

• It is possible to run the render server with less 
processes than the data server, but never 
more.



Parallel Paraview

• Paraview can be run in a variety of 
configurations
– Client, Data Server and Render Server all running 

on the same process (the way we have been 
running this week)

– Client as a single process program, Data Server and 
Render Server as MPI multi-process programs.

• MPI is used to send messages between processes
• Sockets are used to send messages and data between 

servers



Running Parallel Paraview through VNC 
Session on Ranger

• Login to login3.ranger.tacc.utexas.edu
• Set your vnc password by typing ‘vncpasswd’
• Start a vnc server: vncserver
• Pay attention to the display number on ranger as this is the 

one you are going to connect to
• Point vnc client to that adisplay:

– E.g., ‘Login3.ranger.tacc.utexas.edu, using display 3’
• This will bring up a vnc window



Running Parallel Paraview through VNC 
Session on Ranger

• Look for the file ‘job’ in your home directory. This is your job 
script

• Type ‘module delete mvapich2’
• Type ‘module swap pgi intel’
• Type ‘module load mvapich’
• Type ‘module load vis’
• Type ‘module load mesa’
• Type ‘module load qt’
• Type ‘module load paraview’



Running Parallel Paraview through VNC 
Session on Ranger

• Type ‘qsub job’
• Type ‘showq –u’ to see when you job starts to run
• When the job starts to run, do a ‘qstat’ to find your job. Look for the 

compute node you are running on
– Example: If the compute node is: i115-406.ranger.tacc.utexas.edu, 

you compute node is i115-406
• Run paraview by typing ‘paraview’
• Open the server dialog with:  File -> Connect
• Click “Add Server”
• Enter a name, for example: i115-406 (look at qstat and look for compute 

node assigned to you)
• For “Server Type” select “Client / Server”



Running Parallel Paraview through VNC 
Session on Ranger

• For host, enter the compute node address, 
e.g.: i115-406.ranger.tacc.utexas.edu

• Click the “Configure” button
• For “Startup Type:” select “Manual”
• Click “Save”
• Under “Choose a server:” select the name 

you just entered, e.g. i115-406
• Click “Connect”



Running Parallel Paraview through VNC 
Session on Ranger

• NOTE:   you will get a message that says 
rendering disabled on server.  This is okay.

• NOTE: you will need to configure a new 
server each time the compute node changes, 
which will likely be each time you run 
ParaView.  



Running Parallel VisIt through VNC 
Session on Ranger

• Login to login3.ranger.tacc.utexas.edu
• Start a vnc server: vncserver (if not already running)
• Pay attention to the display number on ranger as this is the 

one you are going to connect to
• Point vnc client to that adisplay:

– E.g., ‘Login3.ranger.tacc.utexas.edu, using display 3’
• This will bring up a vnc window



Running Parallel VisIt through VNC 
Session on Ranger

• Type ‘module delete mvapich2’
• Type ‘module swap pgi intel’
• Type ‘module load mvapich’
• Type ‘module load vis’
• Type ‘module load mesa’
• Type ‘module load qt’
• Type ‘module load visit’



Running Parallel VisIt through VNC 
Session on Ranger

• Launch VisIt by typing ‘visit’
• Configure a parallel run engine:

– Open the host profile: <Ctrl+H> or Options -> Host Profiles
– Click the button “New Profile”
– Under the “Selected profile” tab:

• Name the profile, e.g. “ranger-login3”
• Remote host name will be the current login node, e.g. 

login3.ranger.tacc.utexas.edu
• Check the “Parallel computation engine” box 

(this activates the “Parallel options” tab)



Running Parallel VisIt through VNC Session on Ranger

• Under the “Parallel options” tab:
– Check the “Parallel launch method” box, and select “qsub/srun”
– Check the “Launcher arguments” box, and enter arguments that you 

would put at the top of a job script, except for the queue (-q) and the 
account information (-A).  For example:

-V –cwd –N visit_engine –j y 
–o $JOB_NAME.o$JOB_ID –pe 16way 16 
–l h_rt=00:30:00

– Check the “Partition / Pool” box, and enter the queue name.  This will 
usually be “normal” or “development”

– Set the “Default number of processors” field to a value greater than 
one.  The exact value is ignored, but it must be 2 or more to avoid 
automatic launch of the serial engine.  The number of processors
requested is controlled by the “-pe” argument in the “Launcher 
arguments” field above.

– Check the “Default Bank” box, and enter the account to charge 
against: A-tr3



Running Parallel VisIt through VNC 
Session on Ranger

– Under the “Advanced options” tab:
• Check the box “Use VisIt script to set up parallel environment”
• Check the box “Tunnel data connections through SSH”

– Click the button “Apply”
– Click the button “Dismiss”

• Save your configuration!  Select Options -> Save 
Settings

• When you load a data file, a dialog will open where 
you can select the host configuration.  Here you can 
change the account you would like to use, if needed.



Questions?
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